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Access Fundamentals

Microsoft Access is a powerful database program you
can use to store all kinds of information—from a
simple list of contacts to an inventory catalog with tens
of thousands of products. Once information is stored in
a Microsoft Access database, it’s easy to find, analyze,
and print.

This chapter is an introduction to working with Access.
We don’t get into great depth here, but we make sure
you understand the key parts of Access, such as tables,
forms, queries, and reports. You'll learn about the main
components of the program screen, how to work with
database objects, and how to use help.

Objectives

Introduction to Databases
Understand the Screen
Open and Save a Database
Work with Database Objects
Tour of Tables

Tour of Queries

Tour of Forms

Tour of Reports

Help

Close and Exit Access
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Introduction to Databases\

In its simplest form, a database is a collection of information organized into a list. Whenever you make a list
of information, such as names, addresses, products, or invoices, you are, in fact, creating a database.
Technically speaking, you don’t even have to use a database program to create a database. You can make a
list of information in all kinds of programs, such as Microsoft Excel or Word.

A database program, however, is much more powerful than a simple list you keep on paper or in a Microsoft
Word document. A database program lets you:

e Store Information: A database stores lists of information that are
related to a particular subject or purpose. A database stores
personal information, such as a list of Aunt Mildred’s home recipes,
or business information, such as a list of hundreds of thousands of
customers. A database also makes it easy to add, update, organize,
and delete information.

e  Find Information: You can easily and instantly locate information
stored in a database. For example, you can find all the customers
with the last name “Johnson” or all the customers who live in the
55417 ZIP code and are older than 65.

e Analyze and Print Information: You can perform calculations on
information in a database. For example, you could calculate what
percent of your total sales comes from the state of Texas. You can
also present information in a professional-looking printed report.

e Manage Information: Databases make it easy to work with and
manage huge amounts of information. For example, with a few
keystrokes you can change the area code for hundreds of
customers in the (612) area code to a new (817) area code.

e Share Information: Most database programs (including Microsoft
Access) allow more than one user to view and work with the same
information at once. Such databases are called multi-user databases.

Commented [JH1]:
Practice File: None

Describe what a database is and discuss its capabilities.

8 [Your Company Name]



Database Objects

Databases usually consist of several parts. A Microsoft Access database may contain up to seven different
database object types. Some objects you will use all the time (such as Tables), while others you may hardly
ever use (such as Modules).

Database Objects -

E Tables Tables store a database’s data in rows (records) and columns (fields). For
example, one table could store a list of customers and their addresses while
another table could store the customers’ orders. A database must always
contain at least one table where it can store information—all the other database
objects are optional.

= Queries Queries ask a question of data stored in a table. For example, a query might only
display customers who are from Texas.

Forms Forms are custom screens that provide an easy way to enter and view data in a
table or query.

Reports Reports present data from a table or query in a printed format.

K

Macros Macros help you perform routine tasks by automating them into a single
command. For example, you could create a macro that automatically opens and
prints a report.

g&: Modules Like macros, modules automate tasks, but they do so by using a built-in
programming language called Visual Basic or VB. Modules are much more
powerful and complex than macros.

2025 CustomGuide, Inc. 9



]Understand the Screen

There is a lot going on with the Access program screen, so this lesson will help you become more familiar
with it. Review the labeled items in the images below, then refer to the tables to see what everything does.

- CustomersTours: Database- \\ 5 ? 1
i Create External Datr Database Tools Fields Table you want to do... Kayla Claypool
b/‘ B_ g Y 2| Ascending @ = > b |Calibri -1 -
s Egy %l Descending 'Cl - |—=,H J:l; =>- B I u EH .
View Paste Filter Refresh Find B .
- Remove Sort All~ x - D' k - A~ ag & o= == zﬁﬂ o
Views Clipboard Sort & Filter Records Find Text Formatting ] -
All Access Obje... @ « || F Employees, all
Tables N o] ~ | LastNa FirstName ~ Title ~ | HireDate ~-| Address
Ry 1 Leverling Janet Sales Represer 4/1/1992 722 Moss Bay|
Queries - 2 Peacock Margaret Sales Represer 5/3/1993 4110 Old Red
5 Ush Employees 3 callahan Laura Inside Sales Co 3/5/1994 4726 - 11th A
4 Davolio Nancy Sales Represer 5/1/1992 507 - 20th Av:
Forms # 5 Fuller Andrew Vice President 8/14/1392 308 W. Capita
& Employees 6 Suyama Michael Sales Represer 10/17/1993 Coventry Hoy
Reports 2 7 King Robert Sales Represer 1/2/1994 Edgeham Hol
B employee Lst 8 Buchanan Steven Sales Manager 10/17/1993 14 Garrett Hil
9 Dodsworth Anne Sales Represer 11/15/1994 7 Houndstood
11 4/1/1992
* (New)
Record: H 10f10 L3 T 3 Mo Filter | |Search 4 3
Datasheet View Mum Lock E,;_ﬁ,

o Title Bar: Displays the name of the current o Help/Display Options: Here you can
file. change how much of the ribbon is
displayed; minimize, maximize or restore
the screen; or close Access altogether.

e Quick Access Toolbar: This is a fast way to Q The Ribbon: This is where you’ll find all the
access the most used features. options you need to make a database. The
options are grouped into tabs.

Commented [JH2]:
Practice File: New blank Access database.

Discuss the appearance of the Access window.

Especially point out how the ribbon and its tabs contain
most of the commands needed to put together a database.
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& CustemersTours: Database- \Cus...

Create External Data Database Tools

Fields

Table

Q Tellm

‘ X Y 2] Ascending Y - @ = > b |calibri -1 -
E@ El Descending '|:|v EE tl} >~ B I U F
Paste Filter Refresh Find - o
- Remove Sort Ale Xt M= k- A-® D ==
Views Clipboard = Sort & Filter Records Find Text Formatting ] -~
: - Empl
All Access Obje... ® « = employees
Tables N ID ~ | LastName - | FirstName -~ Title ~| HireDate - Address
EE R 1 Leverling Janet Sales Represer 4/1/1992 722 Moss Bay|
Queri " 2 Peacock Margaret Sales Represer 5/3/1993 4110 Old Red
uenes ~
& usaEmpl 3 callahan Laura Inside Sales Co 3/5/1994 4726 - 11th A
+ mployees
; Py 4 Davolio Nancy Sales Represer 5/1/1992 507 - 20th Av:
5’"5 . 5 Fuller Andrew Vice President  8/14/1992 908 W. Capitd
=2l Employees 6 Suyama Michael Sales Represer 10/17/1993 Coventry Ho
Rports - 7 King Robert Sales Represer 1/2/1934 Edgeham Hol
@ employee List 8 Buchanan Steven Sales Manager 10/17/1993 14 Garrett Hil
9 Dodsworth Anne Sales Represer 11/15/1994 7 Houndstoo
11 4/1/1992
* {New)
] Record: M 10of 10 L lo Filter | [Search 1 ¥
Datasheet View Mum Lock b

File tab: This is where you'll find basic file
management commands, such as New,
Open, Save, Close, and program options.

Microsoft Account User Info: When you
log in with your Microsoft account, your
name and picture appear here.

Access Object: The Access Object is where
you can view the content of the open or
selected database object.

View buttons: Use one of the view buttons
to quickly switch between the different
views.

© 2025 CustomGuide, Inc. 11



v CustomersTours: Database- \Cus... Table Tools
Create External Data Database Tools Fields Table ':' Tell me
b(‘ X Y 8| Ascending Y- @ = > 2. | Calibri
B %l Descending Tl - a8 T 3- BT U
View Paste Filter Refresh Find -
- Remove Sort All = x-H L - A-C
Views Clipboard = Sort B Filter cords Find Text Formatting (] ~
- = Empl x
All Access Obje... ® « || F Emeloyees,
] - Name - | FirstName -~ Title ~| HireDate ~-| Address
Tables x :
R 1 Leverling Janet Sales Represer 4/1/1992 722 Moss Bay|
Queri . 2 Peacock Margaret Sales Represer 5/3/1993 4110 Old Red
UEnes x
F usa empl 3 callahan Laura Inside Sales Co 3/5/1994 4726 - 11th A
+ mployees
E P 4 Davolio Nancy Sales Represer 5/1/1992 507 - 20th Avi
I%""s . 5 Fuller Andrew Vice President 8/14/1392 908 W. Capita
=l Employees 6 Suyama Michael SalesRepreser  10/17/1993 Coventry Hou
Reports - 7 King Robert Sales Represer 1/2/1994 Edgeham Hol
B employee List 8 Buchanan Steven Sales Manager 10/17/1993 14 Garrett Hil
B
9 Dodsworth Anne Sales Represer 11/15/1994 7 Houndstood
11 4/1/1992
* (New)
I Record: M 1of 10 kM Mo Filter | |Search 4 - »
Datasheet View Mum Lock E,;é,

Scroll bar: Use the scroll bar to view
different parts of the database object.

Status bar: The Status bar displays
messages and feedback.

L

Navigation Pane: The Navigation Pane is
where you can see and open your database
objects, such as tables, queries, forms, and
reports.

Object tab: A tab appears for each open
database object. Click a tab to view and
work with that object.
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\Open and Save a Database\

To make changes to an existing database, you'll first need to open it.

\Open a Database

o

Commented [JH3]:

As a best practice, create fresh copies of the practice files
for each instance of your classes. The files are used for
multiple lessons and altered too much to reuse after
completing a course.

Practice File: Employees.accdb

Click the File tab.

Click Open. The databases
you’ve recently opened show
up here.

Select the location where the
file is saved.

o If you're signed into your
Microsoft account, you can
open files directly from
OneDrive.

e Or click Computer to open a
database that is saved
locally to your computer.

Click Browse.

Navigate to where your file is
saved and select the file you
want to open.

Click Open.

The database opens.

Access

Create  ExternalData  Database Tools Q@ Tellm u want to do. Kayla Claypool

Commented [JH4]:
1. Click the File tab.

2. Click Open.

3. Select the location where you have saved your practice
files.

4. Click Browse.

5. Navigate to the Practice Folder for Access 2016 and
select the Employees.accdb database.

6. Click Open.

7. Make necessary changes to the file.

Ascending >
Descending v B I
Paste Filter Refresh Find h
Remove Sort Al A -3
Views Clipboard Sort & Filter Records Find Teut Formatting ~
Access - o x
Kayla Claypool
@ R ] E;I Computer -
Recent Folders
& OneDrive Documents
Wpsf » Home » Documents
= Desktop
E;l Computer \\psf » Home » Desktop
== Addapiace
Account
Options
Browse \
v
? =B
ayla Claypool
B Open X
« v <« Desktop » Customers ~ ©  Search Custormers P
Organize = New folder = M @ =
# Quick access Name Date modified Type
mw A 0 Employees 11/20/20152:28PM  Microsoft Ac
crosoft Access
@ OneDrive B
[ ThisPC
) Network
o4 Homegroup
Account
Options
< >
File name: Microsoft Access (*accdb;ume ~
Teols v Cancel

~— 0

© 2025 CustomGuide, Inc. 13




]Save a Database

Now that an edit has been made, let's save the database.

0 Click the File tab. B o- S ——
File Home Create. External Data Database Tools
e Click Save As.

=
[§ £= Insert Rows iz
3X Delete Rows
Primary Builder Test Validation Property Indexes  Create Data  Rename/

If you want to save the file in - ke Rules  EQModify Lookups  Speer Macros™  Delete Macro

Views Tools Showytide _ Field, Record & Table Events

Relationships

Kayla Claypool

=

Object.

Dependencies

Commented [IG5]:

1. Click the File tab.
2. Click Save As.
3. Select Desktop.

4. Click Save.

the same location, just click
Save.

o Select the location where you

want to save the file.

BB saveAs X
o Click Save. « © 4 B> CustomGuide > Desktop > Search Desktop »
Organize w New folder = @
The file is saved. > % Quick access Name Ditemodifies | Type
Customers 11423720 File folder
> [ Microsoft Access
> @ OneDrive
~ B ThisPC
> B Deskiop
> Documents
> & Downloads
Account & b M=
> [&=] Pictures
v« >
Options.
A customeTou s .accd) v
Feedback
Save as type: | Microsoft Access Database (*.accdb) -
= Hide Folders Tools + Cancel

6
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\Work with Database Objects\

Commented [JH6]:
Practice File: Employees.accdb

\Use the Navigation Pane\

Think of the Navigation Pane as the mission control center for an Access database. You use the Navigation
Pane to open and manage the different types of objects in your database.

Click the arrow button at the
top of the Navigation Pane to
select the type of object(s) you
want to display.

The Navigation Pane can
display different types of
Access objects. You can change
the view settings to view all
the database objects in this
database.

Select Object Type and make
sure there’s a check mark next
to All Access Objects.

A menu displays, listing the different
types of database objects you can
display.

\Open a Database Object

Double-click an object in the
Navigation Pane.

The Navigation Pane contains buttons
for each type of database object.

Create

View Paste . Filte

Views _Clipboard
Forms
Navigate To Category
Custom
Object Type
Tables and Related Views
Created Date
Meodified Date
Filter By Group
Tables

Queries

Foms

Reports
All Access Objects

Ready

Create

Views  Clipboard

® «

Employees:
External Data
Ascending
Descending
Remove Sort

Sort & Fiter

°

°

Employ
External Data

es
Remove Sort

Sort & Fitter

All Access Obje.
Tables

EB employees
Queries

B USAEmployees
Forms

B employees
Reports

B employee List

@ «

. |

Ready

tabase- \Employees.accdb (Act

Database Tools

EM

Refresh
M X

Records

tabase- \Employees.acedb

Database Tobls

Refresh
x -

Records

Q you want8do..

(Aecess 2007 — 2016 file format) A

Q Tell mewhat y

Find

07 - 2016 file format) A o

Kayla Claypool

Text Formatting ~

u]

Kayla Claypool

Text Formatting ~

Commented [JH7]:
1. Click the arrow button at the top of the Navigation
Pane.

2. Select All Access Objects.

Commented [JH8]:
1. Double-click the Employees form.
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]Switch Object Tabs

If you have multiple objects open, you can use the tabs to switch between objects.

Click the tab for the object you
want to display.

The object appears on the screen as a
tabbed item.

As you open additional objects, they

stack on top of each other in the same
window. To bring a different object to
the top, where it’s visible, click its tab.

Create

%
E
View  Paste o Fite

Views _ Clipboard 1

All Access Obje.
Tables

= empioyees
Queries

2 ush Employees
Forms

B8l employees
Reports

IS Employee List

Ready

Employees: Databs

Extemal Data

Ascending

Database Tools

Descending e -
Remove Sort Al- X~ A -3
1 il Bacasd - P 2
enposees (T3 enoioees (1 s envioees | empioyee it_| x
N Em ployhlst
LastName FirstName Title Address City State
° Leverling  Janet sales 722 Moss Bay Blvd.  Kirkland WA
Representative
Peacock Margaret  Sales 4110 0ld Redmond Redmon WA
Representative Rd. d
Callahan Laura Inside Sales 4726- 11th Ave.N.E.  Seattle WA
Coordinator
Davolio Nancy Sales 507 - 20th Ave. E. Seattle WA
Representative Apt. 2A
Fuller Andrew Vice President, 908 W. Capital Way Tacoma WA
Sales
Suyama  Michael  Sales Coventry House London
Representative Miner Rd.
King. Robert  Sales Edgeham Hollow London =
i 3

Kayla Claypool

Commented [JH9]:

1. From the Navigation Pane, double-click the Employees

table and USA Employees query to open them

2. Demonstrate switching between object tabs.

]Modify a Database Object in Design View\

Click the View button list
arrow.

o Select Design View.

Tip: You can also modify a database
object in Design view by right-clicking
the object’s tab and selecting Design
View from the contextual menu.

Home [eRS

¢ N Y
4 &

View % Filter
=
s
B Design view

o

Forms

B2 Employees

Reports
[d Eemployee List

Ready

d Tite
Hire Date

Employees: Database- \

External Dato

4| Ascending Y -

| Descending -
Remove Sort

Sort & Filter

® « I =2 Employees |

»

Lasthame

FirstName

Addess
Ciy
State
Zip Code
Country

Phone

Record: M« [10f9

Database Tools

@g‘!% ,ousc

& -
Refresh . Find
Al X~ [
Recoras Find

2007 - 2016 file format) Ac

B I U
Y

Text Formatting

0 Employees "\ USA Employees "\l Employee List \

- o

Kayla Claypool

Hanet
[Sales Representafive.
170471332

[722Moss Bay Blvd.

Kitkland

[206) 5553412

I

NoFilter | [Search

Commented [JH10]:
1. With the Employees form tab open, click the View
button list arrow.

2. Select Design View.
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\Close a Database Object|

Click the object’s Close button
in the upper-right corner of the
window.

The object closes. Remember, closing
an object is different than closing the
entire database.

\Rename a Database Object\

Z  Employees: Databa

Home  Create  BdemalData  DatabaseTools |[MNENUMN Amange  Format

B g it & & B
T SEEF re o HD Add Bisting P dy?: 2
ew ontrols Inse isting Property Ta
- [AlFonis- + imager DatcandTime  Filds  Sheet Order 5
Views  Themes Controls Header / Footer Tools ~
All Access ije_ © «|| = Employees 3 Employees \F51 Usa Employees ([l Employee List x
Tables PO I T R R R R R R SR RS S R SN R T RN ET R RN RT Ry ST
2 employees # Form Header
# Detail

Queries B T T T I
= Ush Empleyees * [aie |Gt ‘
Forme PRI fFiemane — —
B employees T [te D

2
Reports A || % Do [[Fiebate ‘ ‘
{9 Employee List S s e

Ml | |Gty

* Fee [[tete

- (I

. ZnCote 1|Zip Code 1

f
3
© Prom .
# Form Footer

1

< 3
Ready B E &

Commented [JH11]:
1. Click one of the object’s Close button.

In the Navigation Pane, right-
click the object that you want
to rename.

Select Rename from the
contextual menu.

Type a new name and press
Enter.

The object is renamed.

Text Formatting

Address

722 Moss Bay Blvd.

4110 Old Redmond
Rd.

4726- 11th Ave. N.E.

507- 20th Ave. E.
Apt. 24

908 W. Capital Way

Coventry House
Miner Rd.

Edgeham Hollow

7 Employees: Database- \Emj
Create,  Bxternal Data
E S —— @ 5% p B
nding T~ -
View Paste Filter Refresh Find
s All- -
Views  Clipboard Sort & Fitter Records Find
P employees (1 UsA Emplogees Employes List
All Access Obje... @ « || & poyees | Employ i
Tables ‘
BB Employees ;
o op Employee List
—— Open | ploy:
r b€ Design Vi
=F o S5 Design Yiew ame  FirstName Title
Forms Import [ S
B employees B , fling  Janet Sales
. e Export Representative
eporis =
N dk  Margaret  sales
Py Hide in this Grogp Representative
Delete nan Laura InsidesSales
% cut Coordinator
By Copy lio  Nancy sales
Representative
r Andrew  Vice President,
Sales
na  Michael  Sales
able Properties Representative
T king Robert  Sales
1
Ready

o

a

Kayla Claypool

city

Kirkland
Redmon
d
Seattle
Seattle
Tacoma
London
London

o H

o Eaks

State

wa

wa

wa

WA

WA

Commented [JH12]:
1. Right-click any object in the Navigation Pane.

2. Select Rename.

3. Explain how you can rename an object at this point, but
don’t actually rename any objects.

© 2025 CustomGuide, Inc.
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]Delete a Database Object

o Select the object you want to

delete in the Navigation Pane.

e Press the Delete key.

e Click Yes to Confirm the
deletion.

The object is deleted.

te

External Data

ding

Descending oI

View  Paste Filter
> Remove Sort
Views  Clipboard = Sort & Fiter

All Access Obje... @ «

Tables A
I Dpestinations

nplo

[&

Refresh
All~

Database Tools

Records Find

Text Formatting

2 Employees (1 UsA Employees I8l Employee List

‘o‘ Employee List

E5 Employee
PV Microsoft Access X
Queries State
B usaempl Do you want to delete the table ‘Destinations’? Deleting this object will remove it from all groups. WA
F
orms 1" Formore information on how to prevent this message from displaying every fime you delete an bjec, dick
E employees Help.
A WA
eports tes No Help
B empioyee
Callahan a Inside Sales 4726- 1ithAve. NE.  Seattle WA
Caordinator
Davolio  Nancy  Sales 507-20th Ave. E. Seattle WA
Representative Apt. 28
Fuller Andrew  Vice President, 903 . Capital Way ~ Tacoma WA
sales
Suyama  Michael  Sales Coventry House London
Representative Miner Rd.
King Robert  Sales Edgeham Hollow London
< v
Ready Bl = = ¥

Commented [JH13]:
1. Select an object in the Navigation
Pane that isn’t currently open.

2. Press the Delete key.

3. Click No to cancel the deletion (don’t actually delete the
object).
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Tour of Tables s e

Tables are the heart and soul of any database. They’re where a database stores all its information. All the
other database objects are merely tools to analyze and manipulate the information stored in tables.

\Open a Table\ Commented [JH15]:
1. Double-click the Employees table from the Navigation
o Double-click the table you * Employees Database- \emp : Pane.
Want to Open in the Navigatlon Create External Data Database Tools Fields Table Q Tell me.
v/ £l Ascending Wi - = X e [calibri S -
Pane. 5"‘ ol ? “lDescending T3+ M@h 8% 7 u
ERL= el =
The table opens as a tab in the il socen T S Records Find Text For IS
X P All Access Objec...® «|| = emploress - : _ 2
window. Tables R D i Lasll;lame ~ | FirstName - ITltIe - leeD;i; | Address
L B Leverling Janet sales Represer 4/1/1992 722 Moss Bay
;j Emlesess Y 2 Peacock Margaret sales Represer 5/3/1993 4110 Old Rec
sj‘;‘"ei © 3 Callahan Laura Inside Sales Co 3/5/1994 4726 11th A
Of course, before you can open a table, | = v X Somolle  Neney  Sslesnepreser 5/iiss2 s07-20th Ay
: o s 5 Fuller Andrew Vice Precident  8/14/1992 508 W. Capit
someone will need to have already & erployees 6 Suyama Michael SalesRepreser  10/17/1993 Coventry Ho
created the table, or else you'II need to Reports A 7 King Robert Sales Represer 1/2/1994 Edgeham Ho
4 B emproyee st 8 Buchanan Steven Sales Manager  10/17/1393 14 Garrett Hi

be using a database template that 9 Dodsworth  Anne salesRepreser  11/15/1994 7 Houndstoa
* (New).
already has tables created for you.

Record: 4 [10f3 | » mp Mo Filter | [searcn < 3
Datasheet View Num Lock &

© 2025 CustomGuide, Inc. 19



Parts of a Table\

Let’s take a closer look at the current table and identify its different components.

= Employees: Database- \Emp... Table Tools

Create External Data Database Tools Fields Table '-:-' Tell me...

‘ 2| Ascending Y - = > b Calibri
i}

Em %] Descending  Tol - & v 3- B I U
View Paste Filter Refresh Find .
- - Remove Sort All - - BH- fs - A
Views Clipboard Sort & Filter Records Find Text Formatting ] £
&« T Employees ®

All Access Objec...¢

Commented [JH16]:
Describe the different components of a table.

Leverling anet Sales Represer 4/1/1992 722 Moss Ba

1D - | LastMame - | FirstName - Title - | HireDate - Address
Tables I
T Employees

Peacock Margaret Sales Represer 5/3/1993 4110 Old Req

Queries %

& ush Empl 3 Callahan Laura Inside Sales Co 3/5/1994 4726 - 11th Al
+ mployees

v ey Davolio Nancy Sales Represer 5/1/1992 507 - 20th Ay
orms = oﬁ Fuller Andrew Vice President 8/14/1992 308 W. Capit
= uyama ichae ales Represer oven o
B employees Suy Michael Sales Rep 10/17/1993 Coventry H
Reports *

King Robert Sales Represer 1/2/1994 Edgeham Ho
Buchanan teven Sales Manager 10/17/1993 14 Garrett Hi

9 Dodsworth nne Sales Represer 11/15/1994 7 Houndstoqg
* (New)

ﬁ Employee List

—
IRe(m'd: Al 10f9 L o Filter | |Search I< >I
. ~—— ~—

Datasheet View Num Lock =4

em

o Fields: Tables are made up of groups of fields. A field is a specific type of information, such as a
person’s last name, address, or phone number.

Records: Together, the related fields for each individual person, place, or thing make up a single
record.

Datasheet: Table information is displayed, entered, and modified in a datasheet. A datasheet is a
grid that contains all the records in a table.

Record selector: The record selector shows indication of the record that you are currently
working on.

Record Navigation bar: You use the Record Navigation bar buttons to move through the records
in a table.

© © 0 0

Scroll bars: Tables usually contain too much information to display on the screen at once, so
you'll have to use the scroll bars to see all of it.

20 [Your Company Name]



Next, look at the record navigation buttons near the bottom of the screen, as shown in the table below. The
record navigation buttons on the Record Navigation bar display the number of records in the current
database and allow you to move between these records.

Record: M 1of9

Go To

Next record

Previous record

First record in a table

Last record in a table

New blank record

Search for records
using keywords

PoM b
Navigation Buttons

Click the * Next record
navigation button.

Click the * Previous

record navigation button.

Click the ' First record
navigation button.

Click the M Last record
navigation button.

Click the ¥ New (blank)

record navigation button.

Type a keyword in the
Seareh box next to
the navigation buttons.

Search

Keyboard

Press the <J{,> arrow
key.

Press the <> arrow
key.

Press <Ctrl> + <Home>
(when not editing
record).

Press <Ctrl> + <End>
(when not editing

record).

N/A

N/A

Mouse

Click the record you want
to select (if displayed).

Click the record you want
to select (if displayed).

N/A

N/A

Click in the (New) row at
the end of the table.

N/A

© 2025 CustomGuide, Inc. 21



h’our of Queries\

A query asks a question about the information in one or more tables and then retrieves the results.

For example, if you wanted to know which employees had worked for the company for more than five years,
you could create a query to examine the contents of the Hire Date field to find all the records in which the
hire date is more than five years old. Access would retrieve the information that meets your criteria and

display it in a datasheet.

]Open a Query\

Double-click the query you
want to open in the Navigation
Pane.

Notice that the query doesn’t look any
different than a table. Information is
displayed in a datasheet, and you can
even edit records in some queries. But,
the information in a query isn’t a
duplication of the data in a table—it’s
just another way of looking at it.

Create
b *
Yy
View Paste Filter

Views  Clipboard 1

All Access Obje
Tables

= employees
Queries

B USA Employees
Forms

B Employees
Reports

@ employeevist

Datasheet View

External Data

4| Ascending

Y
%l Descending T~

o @ @B E pés‘ cmm

& v

3- B I U

O

Commented [JH17]:
Practice File: Employees.accdb

Commented [JH18]:
1. Double-click the USA Employees query from the
Navigation Pane.

Remove Sort Riﬁh x-HE- fnd R- A-¥-2-
Sort & Filker Records Find Tert Formatting oA
® « || = Employees %
N ID  -[ LastName - FirstName -| Title - | HireDate -| Address
= 1leverling Janet Sales Represer 4/1/1992 722 Moss Ba
N 2 Peacock Margaret Sales Represer 5/3/193 4110 0ld Red|
- 3 Callahan Laura Inside Sales Co 3/5/1994 4726 - 11th A
i 4 Davolio Nancy sales Represer 5/1/1992 507 - 20th Av¢
- 5 Fuller Andrew Vice President 8/14/1992 908 W. Capit:
6 Suyama Michael SalesRepreser  10/17/1393 Coventry Ho
* 7 King Robert sales Represer 1/2/1954 Edgeham Hol
8 Buchanan Steven Sales Manager 10/17/1993 14 Garrett Hil
9 Dodsworth  Anne SalesRepreser  11/15/1994 7 Houndstoos
11 4/1/1932
* (New)
Record: W_([10f10 | » bl » No Fiter | [Search < v

Numlock | [ &
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\Display a Query in Design View

In Design View, you can see a query’s underlying tables, which fields are included in the query, and the

criteria used to specify which records to display.

Click the View button on the
ribbon.

4 X% 5| Ascending Vi - = X % [caliori A
E‘lé' ﬂa I 21 Deicend\:g ™- RE@H:B "3 {Dd 3- B I U [E=
In Design View, you can see a query’s - Pz e X - B B oA- oL -

a e Views _Clpboard = sort & Fiter s Fing o rarn SO 5 A
underlying tables, which fields are All Access Obje... © « | = Ushtmolores x
included in the query, and the criteria e B

) - JE— :
used to specify which records to Queries » [l Aaney £
- Fuller Andrew UsA
display. 1 Ush Employces — Leverling  Janet usa
Fi:Im: ‘ A Peacack Margaret UsA
3 tmployees =
. . . Reports ES
Tip: You can also display a query in =
Design View by right-clicking the query
object in the Navigation Pane and
selecting Design View. Or, click the
Design View button in the Status bar.
R <frars v v | Fovoriter e
Datasheet View B o b

\Change a Query’s Criteria

Select the information you
want to edit in the Criteria row
and type in your changes.

=

View Run

Resuts

All Access Obje.
Tables

B employees

Queries

=3 UsaEmployees
Forms

B Employees

Reports.

B employee List

Form View

Home  Create

EE 5 +!

Select Make Append
Table

Emplo

te B

S Employe

@«

atabase- \Employ

ernalData  Database Tools

atabase- \Custom

an

ExtemalData Database Tools [ENEN © Kayla Claypool
#!Update QD Union + 2= InsertRows " Insert Columns >
[ Crosstab @& Pass-Through eRows X Delete Columns sl
ow Z
Ix Delete £ DataDefinition  Tgpje < Builder T8 Return: | All | Hider
Query pe Query Setup -
=3 USA Employees X
Employees
Firsthiam
Title
HireDate
Address ™
<« y
Field: | FirstName Country
Table: |Emplayees Employees Employees
sort: [seanding Aseending
Show:
Criteria

© 2025 CustomGuide, Inc.
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Commented [JH19]:
1. Click the View button on the ribbon.

Commented [JH20]:
1. Replace the text “USA” in the Criteria row for the
Country field with the text “UK.”




]Display a Query in Datasheet View\

° Click the View button on the =
ribbon Home  Create  ExtemalData  Database Taols Design Kayla Claypool
: D lj_—‘ I:I o+l #Update D Union + B U Insert Columns >
J * [ Crosstab & Pass-Through DeleteRows ¥ Delete Columns.
. . View Run Select Make Append v Show | iy Show/
Access runs the query and displays its E bebsie  RDaDsmnon | e iNwcsr  IReufw | e
d Results  Quey e Query setup P
records. : = usa empl x
All Access Obje 5 s tmployees
Tables Employees
EH Employess =
FirstNam
Queries Title
£ Ush Employees HieDatel
Forms adaress |~
2 employees
Reports : >
@ emproyeeust Fiela ! Fustame Country
Table: |Employees Employees Employees
Sort: | Ascending ascending
Shouw: (m]
Criteria: UK
or
< D
Form View B = 2

Commented [JH21]:
1. Click the View button on the ribbon.
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Commented [JH22]:

h-ou r Of FO rmS Practice File: Employees.accdb

Forms make it easy to view and work with the information in tables and queries. Forms can include fill-in-
the-blank fields, check boxes, drop-down lists, buttons, and more.

There are a few different kinds of forms in Access:

e Form: A traditional form view. In Layout view, you can edit the form design while also displaying
data.

e Split form: Creates a split screen that allows you to view information through a Form view and
Datasheet view at the same time. You can use the Datasheet view to locate a record and the Form
view to edit it.

e Multiple items form: Allows you to view multiple records at a time—unlike a regular form where
you can only work with one record at a time. It looks much like a datasheet, but allows for more
customization.

e Other forms types: You may also come across forms that look like datasheets, or Modal Dialog
forms that pop out in their own dialog box windows (instead of appearing as tabbed items next to
the other database objects in the main database window).

‘Open a Form Commented [JH23]:
1. Double-click the Employees form from the Navigation
o Double-click the form you want * Employies Database- \Employeesaccdb (Access 2007 - 2016 flform) Access 7 ; Pane and switch to Form view, if needed.
to Open in the NaVigatiOn Create External Data Database Tools Q Tell me what you want 15,88 Kayla Claypool
Pane. & i P
Paste Filter s F‘:_v;‘:,h x L Find

Views  Clipboard & Sort & Filter Records Fing Text Formatting -

The form opens in the window in Form | i accese Objec..® «
view. Tables 2

 Employees

Queries z
S Ush Employees

Forms %
B employees

Reports &
B employee List

Reacy
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]Navigate a Form
o Use the record navigation

buttons near the bottom of the

screen to move to the first,
last, next, or previous records.

V\dd a Record

o Click the New Record button
on the Record Navigation bar.

A blank form appears, ready to
accept your information.

o Complete the form fields.

When you're finished typing
information into a form, press
the Tab key to move on to the
next field.

e When you've finished entering
the record, you can close the
form. Click the New Record
button to create another
record, or use the Record
Navigation buttons to view
another record.

A simple form may contain only fill-in-
the-blank style text fields, but many
forms are more complex and may
contain lists, combo boxes, check
boxes, and sub-forms.

i
Y3 ¥

i) B
View  Paste

Views _ Clipboard 1

All Access Objec...® « || Empioyees

Tables
B Employees
Queries

B USA Employees

Forms

] employees
Reports

@ empioyee uist

Form View

5 Employees: Database-

Create  External Data

Y 4| Ascending Y -

@@E p?ﬁ}

Commented [JH24]:
1. Click the Next record button on the Record Navigation
bar.

Fiss 40 Descending Rereh B ¥ g 27 BT U
Remave Sort e X~ k- :
Sort & Fitter Records Find
o | ¥ Losttome e a—
Firsthame. Paret
A | S
Hie Dot i
* Address [722 Moz Bay B
S fow [
" State e
Zip Code [s122
-~ [—
Phane. [EEE
oo o R

B /Y

View  Paste

Views _Clipboard

All Access Objec.. @ « || tmployees

Tables

EH bad Customers
E5 Employees
Queries

S Ush Employees
Forms

B employees
Reports

@ empioyee List

Form View

7 Employees: Database- \Employeesaccdb (Acc

Create , ExternalData  Database Taals

ending T - @ = = p %
Filter ElDE:“"dmg '@V R:heshrz‘u A:ﬁ Find ol ,“
Remo - X+ ly - g
Sort &Filter Records Fing
o | ¥ Lostame e —
FistName [Hargaret
Tl [Gles Remrosertaive
5 |Henas [
Addiess |MID 0ld Redmond Rd.
A o [Fedmand
. State s
- Zip Code =
County I —
Phene A
Record: 4 4[2of10 | > ¥ Fier [ [Search

Commented [JH25]:
1. Click the New Record button on the Record Navigation
bar.
2. Demonstrate how to enter information in a form.
Use Tab to move to the next field.

Use Shift + Tab to move back to the previous field.

3. Close the form.
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Commented [JH26]:

rTO u r Of Re pO rtS Practice File: Employees.accdb

Reports present data in a table or query in printed format. Reports can be a simple list of records in a table
or a complex presentation that includes calculations, graphics, or even charts.

Although you can directly print tables and queries, they don’t have any format or display options.

‘Open a Report Commented [JH27]:
1. Double-click the Employee List report.

Double-click the report you Employees: Datal = 6 file format) Accessh, 7 b u]
want to open in the Navigation S CAckS” . ————

p %
ane. = By " T B I U
View Paste Filter R F!E.j‘f.h x- ind A -
. . views_Cipboar 1 sor & Fiter e ins et Formating &
The report appears in Report View. All Access Objec..® «
Tables A
3 employees
Queries 2
B USA Employees
Forms. z
G Employees
Reports %
B employee s o
U
Reay
\Switch to Layout or Design View Commented [JH28]:

1. Click the View button list arrow.
To edit a report’s structure, you need to change to Layout or Design View.
2. Select Layout View.

o Click the View button list = Employees:Database- \Employcesacedb (A
arrow in the VlewS group on Create External Data Database Tools z :
] 2
the Home tab. = Descending T3+ & L > B I U
v|?~ 0 Filter . W Re:‘r‘%h Find N .
e Select Layout W or Design j Report View Sort & Fiter Records Find Text Formatting -~
View | C..® «|| B Employee List x
4 @ Print Preview B =
Employee List
T H Layout View
MOSt Edlts Can be made n LaVOUt E x 0 LastName FirstName Title Address City State
View, but complex tasks require Design  ||b¢’ pesonview Leverling Janet  Sales TMossBayBive,  Kirkland WA
View — a Representative
: F Enplosees Peacock  Margaret Sales 41100ldRedmond  Redmon WA
Reports * Representative Rd. d

I8 Employee List -
Callahan  Laura Inside Sales 4726- 11th Ave.N.E.  Seattle WA

Coordinator

Davolio  Nancy  Sales 507-20th Ave. E. Seattle WA
Representative Apt.2A
Fuller Andrew  Vice President, 908 W.Capital Way ~ Tacoma WA
sales
Suyama  Michael  Sales Coventry House London
Representative Miner Rd.
King Robert  sales Edgeham Hollow London -
k] v
Report View B 8 %
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]Help\

When you don’t know how to do something in Access, look up your question in the Access Help files. The
Access Help files can answer your questions, offer tips, and provide help for all of Access’s features.

e o

Click the Microsoft Access
Help button on the ribbon.

The Access Help window
appears.

Select a topic or click in the
Search box.

A list of help topics appears.

Type a topic and click the
Search icon.

Click the topic that best
answers your question.

Information regarding the
selected topic displays.

Create

Vie Paste Filter

Views _ Clipboard st

All Access Obje... @
Tables

2 empioyees

Queries

= usa Employees

Forms

B employees

Reports

B employee List

Reacy

Access 2016 Help
©@ene K 9

create table x P

Top categories

|
+ Getstarted
+ Work with Access web apps
+ Design tables
O
+ Understand queries I
+ Create forms

e

Create reports

T

Use expressions |

Formatting ~

Num Lock.
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Create a make table query

Create a make table query. You use a make table query
when you need to copy the data in a table or archive
data. A make table query is a select query that runs
and

Create an Access app from a template
Create an Access app from a template. Organizing your
data with an Access app is fast, and its especially fast if
you use a template to get started.

Create, edit or delete a relationship
Create, edit or delete a relationship. A relationship helps
you combine data from two different tables. Each
relationship consists of fields in two tables, with data

Create an Access app -
support.office.com

Formatting ~

Num Lock.
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Commented [JH29]:
Practice File: Employees.accdb

1. Click the Microsoft Access Help button on the ribbon.
2. Click the Search box.
3. Type “create table” and click the Search icon.

4. Click the first help topic.




Select a specific topic.

(5]

This way, you jump straight to the
topic you really need.

Shortcut: You can also open the Help
dialog box by pressing F1.

Create

Vie Paste Filter

Views _ Clipboard B

ER employees
Queries

B usa Employees
Forms

B employees
Reports

Employee List

Ready

Access 2016 Help
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create table P

Create a make table query

You use a make table query when you need to copy
the data in a table or archive data. A make table
query is a select query that runs and then creates a
new table based on the results. If you already have a
select query you want to use as the basis for a make
table query, use the procedure shown here. If you

go to the sectiof Learn about make table queries)
below.

NOTE This article dcesn‘tspplyésss web apps
—the kind of database you design With Access and
publish online. Seicreale an Access 2pp for more

information.

1. Open your select unes\gn view, or

switch to Design view.

Formatting

u]

Kayla Claypool

Num Lock.
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]CIose and Exit Access

When you're finished using a database, you should close it. When you close a database, however, the Access
program doesn’t stop running. To stop using Access completely, you need to exit the program.

]CIose a Database

Commented [JH30]:

Practice File: Employees.accdb

o Click the File tab. = Eployess Dtabase- Ve 1 @

Create  BtenalData  Database Tools

Q Te Kayla Claypool
o Select Close. % po—— =
E: scending v B
Paste e Filter - Refresh < Find
Remove Sort Al- X7
The database closes. Views _ Clpboard 5 sort& Fiter s Fina [ A
Employees: Database- \Employees.acc.db (Access 2007 - 2016 file format). ? - o X
Kayla Claypool
CustomersTours
C:» Desktop
= Compact & Repair View and edit database properties
it Help prevent and correct database file
Compact & problems by using Compact and Repair.
Repair Database.

Encrypt with Password

Use a password to restrict access to your

Encrypt with database. Files that use the 2007
Account Password Microsoft Access file format or later are
encrypted.

Options

Feedback
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Commented [JH31]:
1. Click the File tab.

2. Select Close.




\Exit Access]

Click the Close button on the
title bar.

The Access program closes.

If prompted to save changes before
exiting, click Yes.

Clicking the Close button on the title
bar also closes any open databases.

Create

%
E
Vew Pae T Fiter

Views  Clipboard

Ready

Access
Database Tools
=
v B I U

Refresh e Y | Find .

Al
Records Fing Text Formatting

Kayla Clay

Commented [JH32]:
1. Click the Close icon.
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